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Publication history

June 2001

March 2000

July 1999

July 1998

Standard, Release 5.00. This version introduces information about:
DMC8, and OTM DECT Manager. This version excludes retired DMC
equipment, associated parts, and DECT Manager (for Windows) in
compliance with Product Bulletin PBME484, and Product Bulletin
PBCE71. This version introduces a new document title Meridian/
Succession Companion DECT and the NTP number 553-3601-203.

This version replaces all previous versions.

Standard, Release 4.00. This version introduces information about:
DECT C4010 handset, C4010 Ex handset, C4020 handset, DECT
Manager fill down for MSMN concentrated DCMs, MSMN
implementation and operation.

Standard, Release 3.00. This version introduces information about:
DECT Manager enhancements to the DECT Manager Connections, User
Administration, Login Module, System Parameter files, and DMC
addressing; the C4610 base station, and the C4010 handset. This
version also introduces changes that improve the on-line and
printed document. This version arranges the handset subscription
chapter in a more logical order.

Standard, Release 2.00. This version introduces information about
the C4040 handset.
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About this guide

How to use this guide

Complete the installation tasks in sequence. Start at the first page
and proceed through the procedures until you reach the end of this
guide.

Target audience

The Meridian Companion DECT Installation Guide provides
information for installers, site maintenance personnel, and
administrators.

Identifying Nortel Networks PBX systems

The following systems are referred to in this guide as Large systems:

e Option 51
e Option 61
e Option 71
e Option 81
e Option 51C
e Option 61C
e Option 81C

The following systems are referred to as Small systems.

e Option 11
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e Option 11E

e Option 11C

e Option 11C Mini

e Succession Communication Server for Enterprise 1000

Call out boxes

CAUTION: Data loss

This symbol alerts you to a procedure that can result in a
loss of data.

CAUTION: Equipment damage

This symbol alerts you to a procedure that can result in
equipment damage.

CAUTION: Electrostatic sensitive device

This symbol alerts you to a procedure that can result in
equipment damage due to ElectroStatic Discharge (ESD).

CAUTION: Service interruption

This symbol alerts you to a procedure that can result in an
interruption of service.

> B PP

DANGER: Electric shock

This symbol alerts you to the risk of a serious injury, or
death, caused by an electric shock.
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DANGER: Serious injury

This symbol alerts you to the risk of a serious injury, or
death, caused by an immediate hazard.

WARNING: Personal injury

This symbol warns you to the risk of a minor or moderate
injury caused by an immediate hazard.

NOTE
This symbol is used to indicate advice.

Step Action

1 This portion of the step action table details the required step.

This portion of the step action table details the action to carry out the
preceding step.
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Hardware Installation Introduction

This chapter contains the following topics:

Beforeyoubegin. . ... .. .. 11

Unpack and examinetheequipment .. ......................... 12

Before you begin

Before you install the DECT system, the following must be
completed:

the site survey
the deployment
the installation of the house wiring for base stations

Before you install the DECT system you must have the following:

site work order
list of equipment to be installed, showing quantities

the Meridian 1 Companion DECT Provisioning Records
(553-3601-102)

a marked-up floor plan

a volt/ohm meter

hand tools and hardware, such as
— screwdrivers and pliers

— spanners and socket wrenches
— drill and drill bits
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— screws and screw anchors
— punch-down tools for MDF and RJ45 surface mount jacks

— cable continuity checking equipment

Unpack and examine the equipment

Complete the following steps:

Table 1: Unpack and examine the equipment

Step Action

1 Check the items shipped for discrepancies against your list of equip-
ment required for the installation.

If any items are missing, take the action that is appropriate for
this situation.

2 Carefully unpack and examine the equipment for damage.

If any items are missing, take the action that is appropriate for
this situation.

NOTE

Store the equipment containers away from the installation area.
Use the containers to return damaged equipment.
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Install Base Station

This chapter contains the following topics:

DECT basestationrules. ...t 13
Install C4600 and C4610 basestations. . ...........c.covvvvnnn. 15

Install Base Station wiringtothe MDF . ...................... 16

Install the C4610 base station external power supply . ........... 21
Install base station in the external housing .. .................... 22
Attach the external housingtoawall . .......................... 25
Connect the external housing wiringtotheMDF .. ............... 27

DECT base station rules

Be aware of the following rules:

DC powered Meridian systems input voltage of at least -48 volts
is required for maximum base station line length.

One hundred ohms is the maximum line length for a C4610 high
traffic base station. If the line measurement approaches 100
ohms then an external power supply should be used.

In the event the exact location is not accessible, mount the
base station as close as possible to the location in the site
survey.

Mount the base station in a vertical position, not horizontally
on a ceiling.

Lead the base station cable directly away from the base station.
Surplus cable can cause base station malfunctions.
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Install Base Station

Place the base station where it is unlikely to be damaged. For
example, a base station in a warehouse must be placed where it
cannot be damaged by a forklift truck.

Surrounding objects must not affect the base station. For
example, a base station in a car park needs to be placed higher
than any vehicle parked next to it.

The minimum distance between two base stations must be
greater than two meters.

Do not mount base stations on large concrete or stone columns,
air ducts or large metal objects.

The external base station is powered from the line connection
and does not require a mains connection.

Use the external housing kit to mount any base station
out-of-doors.

Use the external housing kit for any base station subject to
conductive pollution, or dust which could become conductive
due to expected condensation.

The NTCWOOAB DMC8 and NTCWO1AB DMC8-E is compatible with
M1 X11 Software Releases:

— Release 23 onwards supports, Basic configuration, CLID and
CPND, DECT card addressing within OA&M, 16 users per card

— Release 24B onwards supports 32 users per card
— Release 25 onwards supports MSMN and Concentration

553-3601-203 Standard 5.00 June 2001



Install Base Station Page 15 of 206

Install C4600 and C4610 base stations

Consult your work order and marked-up floor plan to determine the
position of the base station and perform the following steps:

Figure 1: Base station mounting details

553-8142

Key
screw mounting slot
screw and cable tie retaining washer hole
c cable tie grooves
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Table 2: Install C4600 and C4610 base station

Step Action

1 Locate the base station mounting position.

2 Install the base station mounting screw.

If required, drill the holes for a screw anchor and install the anchor.

3 Fasten the base station on the wall or a building protrusion.

Hang the base station on the screw or use cable ties to mount the base
station. Insert the cable ties in the vertical or horizontal grooves on the
back of the base station. Secure the cable ties to the base station with
the retaining washers and screws provided. Fasten the cable ties to
the building protrusion.

Install Base Station wiring to the MDF

Consult your work order and marked-up floor plan to determine the
base station to MDF connections and perform the following steps:

CAUTION: Service interruption

For maximum line length before signal degradation occurs, use
UTP Cat 5 cabling between the base station and the shelf or
cabinet. If the line length exceeds 100 ohms for the 4610 base
station, an external power supply must be used.

The maximum distance when using external power with UTP
Cat 5 cabling is approximately 1.7 km.
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Figure 2: Base station, MDF, and 1/O panel details
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Table 3: Install Base Station wiring to the MDF

Step Action

1 Connect one end of the NTCW10 cable into the base station RJ45 jack.

Use the supplied cable.

2 Install the RJ45 single surface mount jack.

Use the NTCW10 cable length to measure the location of the RJ45 sur-
face mount jack.
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Table 3: Install Base Station wiring to the MDF

Step Action

3 Connect a UTP3/UTP5 cable from the MDF house side to the RJ45 sur-
face mount jack.
Table 4 on page 19 shows the RJ45 plug/socket to MDF connections. For
DMC8s type NTCWOOAB and NTCWO1AB connect from base station 1
to base station 8.
Note: To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC)
IPE modules requires 24 tip and ring pair backplane to 1/O panel
connections. To re-cable NT8D37 from 16 pair to 24 pair, see System
Installation Procedures (553-3001-210), Appendix C.

4 Connect the free end of the NTCW10 cable into the RJ45 surface
mount jack.

NOTE

The BIX tip and ring connections shown in Table 4 on page 19 cor-
respond to standard BIX designation. The first pair are labeled
TO and RO. (See the Installation and Maintenance NTP, section
Planning and Designating the MDF.)
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Figure 3: RJ45 plug/socket connections to base station 1
MDF

553-8144

Table 4: Base station RJ45 to BIX MDF connections

RJ45 pin out of the

plug and socket MDF connection

Base station number

Base station 1 4 T8

Base station 1 5 R8
Base station 1 6 T9

Base station 1 3 R9
Base station 2 4 T10
Base station 2 5 R10
Base station 2 6 T11
Base station 2 3 R11
Base station 3 4 T12
Base station 3 5 R12
Base station 3 6 T13
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Table 4: Base station RJ45 to BIX MDF connections

RJ45 pin out of the

Base station number MDF connection

plug and socket

Base station 3 3 R13
Base station 4 4 T14
Base station 4 5 R14
Base station 4 6 T15
Base station 4 3 R15
Base station 5 4 T16
Base station 5 5 R16
Base station 5 6 T17
Base station 5 3 R17
Base station 6 4 T18
Base station 6 5 R18
Base station 6 6 T19
Base station 6 3 R19
Base station 7 4 T20
Base station 7 5 R20
Base station 7 6 T21
Base station 7 3 R21
Base station 8 4 T22
Base station 8 5 R22
Base station 8 6 T23
Base station 8 3 R23
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Install the C4610 base station external power supply

An external power supply must be installed on the 12 channel base
station if the UTP Cat 5 line length exceeds 100 ohms.

Figure 4: C4610 base station external power

.

!

Table 5: Install the C4610 base station external power supply

Step Action

1 Remove the plastic stopper from the C4610 base station power socket.

The power socket is located next to the yellow LED.

2 Plug the external power supply jack into the C4610 base station
power socket.

3 Connect the external power supply to the AC mains outlet.

(H
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Install base station in the external housing

Consult your work order and perform the following steps:

Figure 5: External housing details

553-8206.EPS
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component mounting plate
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power transformer (not used)
cable connecting box

base station

plate retaining nuts

cable outlet
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external housing cabinet
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Figure 6: Base station mounting details
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CAUTION: Equipment damage

The following procedure requires the removal of the base sta-
tion cover. The circuit board is attached to the base station
cover. Do not damage the circuit board or bend the two anten-
nas on the bottom of the circuit board.

Table 6: Install the base station in the external housing

Step Action

1 Open the external housing cover.

Insert the external housing key and turn clockwise.

2 Remove the base station mounting plate.
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Table 6: Install the base station in the external housing

Step Action

Unscrew the four nuts securing the plate and pull the plate from
the cabinet.

3 Remove the base station cover. See the preceding caution note.

Carefully pry one corner of the cover from the base station, then the
other corner.

4 Remove the base station lower screw hole cover.

Push the screw hole cover out of the base station.

5 Mount the base station to the housing plate.

Affix with the screws as shown in Figure 6.

6 Replace the base station cover.

Snap the cover in place.

7 Connect the connecting box cable to the base station.

Snap the connecting box cable into the base station RJ45 connector.
Lead the cable away from the base station for optimal performance of
the antennas.

8 Replace the base station mounting plate.

Secure the plate with the four nuts.
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Attach the external housing to a wall

Consult your work order and marked-up floor plan to determine the
position of the base station external housing and perform the
following steps:

Figure 7: External housing mounting lugs

553-8209.TIF

Figure 8: External housing wall mounting
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553-8207.TIF
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DANGER: Electric shock
Do not drill into electrical wires embedded in the wall.

Table 7: Attach the external housing to a wall

Step Action

1 Choose the vertical or horizontal mounting position.

See Figure 7 on page 25 for details. Reposition mounting lugs
if necessary.

2 Drill mounting holes in the wall.

Use the drilling jig to align the holes.

3 Mount the external housing to the wall.

See Figure 8 on page 25 for details. Use the screws, and appropriate
inserts, to fasten the housing to the wall.
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Connect the external housing wiring to the
MDF

Figure 9: External housing MDF connection details
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NOTE

The BIX tip and ring connections shown in Table 9 on page 28 cor-
respond to standard BIX designation. The first pair are labeled
TO and RO. (See the Installation and Maintenance NTP, section
Planning and Designating the MDF.)
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Consult your work order and perform the following steps:

Table 8: Connect the external housing wiring to the MDF

Step Action

1 Lead the building cable into the external housing.

Route the cable through the cable outlet in the external housing.

2 Secure the cable in the connecting box.

Use a cable tie-wrap.

3 Connect the external housing wiring from the connecting box to
the MDF.

Note: See Figure9onpage 27 and Table 9 on page 28 for wiring connections.
For DMC8s type NTCWOOAB and NTCWO01AB connect from base station
1 to base station 8.

Note: To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC)
IPE modules requires 24 tip and ring pair backplane to I/O panel
connections. To re-cable NT8D37 from 16 pair to 24 pair, see System
Installation Procedures (553-3001-210), Appendix C.

Table 9: External housing base station to BIX MDF connections

External housing

External housing base station

number connector box pin MDF connection
number
Base station 1 3 T8
Base station 1 4 RS
Base station 1 2 T9
Base station 1 5 R9
Base station 2 3 T10
Base station 2 4 R10
Base station 2 2 T11

553-3601-203 Standard 5.00 June 2001



Install Base Station Page 29 of 206

Table 9: External housing base station to BIX MDF connections

External housing

External housing base station

number connector box pin MDF connection
number
Base station 2 5 R11
Base station 3 3 T12
Base station 3 4 R12
Base station 3 2 T13
Base station 3 5 R13
Base station 4 3 T14
Base station 4 4 R14
Base station 4 2 T15
Base station 5 4 T16
Base station 5 5 R16
Base station 5 6 T17
Base station 5 3 R17
Base station 6 4 T18
Base station 6 5 R18
Base station 6 6 T19
Base station 6 3 R19
Base station 7 4 T20
Base station 7 5 R20
Base station 7 6 T21
Base station 7 3 R21
Base station 8 4 T22
Base station 8 5 R22
Base station 8 6 T23
Base station 8 3 R23
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Install Additional IPE Shelves or
Option 11 Cabinets

This chapter contains the following topics:

Install additional IPEmodules. ............ ... 31
Install additional Option 11 cabinets. .. ........................ 34
Install IPE modulewiringtotheMDF .. ..................... 37
Install Option 11 cabinet wiringtotheMDF .. ................ 41

Install additional IPE modules

Consult your work order and marked-up floor plan to determine if
additional IPE modules are required and perform the following
steps:

NOTE
If you are not familiar with this process, refer to the System
Photo Installation Guide, Task 4, Task 5, and Task 6 or the

Installation NTP.
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Table 10: Install additional IPE modules

Step Action

1 Remove the IPE module front and rear covers.

Remove the covers from the module, on which the DECT module
will sit.

2 Remove the air grills.

Release the air grill tabs or Southco® fasteners and lift the air grill off.

3 Remove the top cap.
Loosen and remove the three front and rear top cap bolts. Lift off
top cap.

4 Unfasten the column LED.

Remove the LED bracket bolts.

5 Remove the I/O back panel cover.

Unlock the four Southco fasteners.

6 Disconnect the column LED.

Unlock LED wiring connector latches on the module backplane. Detach
the LED wiring connector.

7 Disconnect the thermal sensor connector.

Unlock the sensor connector latches on the 36 pin orange/brown col-
ored connector, located to the left of the LED connector. Unplug the
sensor connector.

8 Remove the EMI perf panel.

Lift directly up.

9 Place the new module on top of the column.

Keep your hands and fingers out from under the module when placing
the module on top of the equipment column.

10 Connect the new module wiring.
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Table 10: Install additional IPE modules

Step Action

Install the sensor connector of the new module into the vertical con-
nector housing of the module below.

11 Secure the new module.

Insert the five bolts and lock washers into the base of the new module.
Tighten the bolts into the original module.

12 Attach the power cable.

Connect the ribbon cable of the new module to J2 of the module below.

13 Reinstall the EMI perf panel and the LED.

Install the LED connector and the sensor connector on the
new module.

14 Replace the air grills and covers.

Reverse the procedure for steps 1 to 4.

Meridian/Succession Companion DECT Installation Guide



Page 34 of 206 Install Additional IPE Shelves or Option 11 Cabinets

Install additional Option 11 cabinets
Consult your work order and marked-up floor plan to determine if
additional Option 11 cabinets are required and perform the
following steps:

NOTE

If you are not familiar with this process, refer to the Option 11
Installation Guide, Chapter 6.

CAUTION: Electrostatic sensitive device

Wear a properly connected antistatic wrist strap to handle cir-
cuit cards. Handle cards by the edges only. Do not touch the
contacts or components. Set the cards on a protective anti-
static bag. If an antistatic bag is not available, hand hold the
card, or set it in a card cage unseated from the connectors.

Table 11: Install additional Option 11 cabinets

Step Action

1 Mount the expansion cabinet.

For a wall mount, draw a level line, rest the bottom of mounting bracket
on the line, screw the mounting bracket to the wall. Hang the cabinet
on the mounting bracket. Fasten the bottom of the cabinet to the wall.
For a floor mount, install the cabinet on the pedestal. Position the cab-
inet according to the equipment layout plan.

2 Remove the drip tray.

Slide drip tray outward.
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Table 11: Install additional Option 11 cabinets

Step Action

3 Install ground wire.
Use as a minimum, #6AWG ground wire. Tag the main ground connec-
tion at the ground source to ensure it is not accidently discontinued.
Test the ground.

4 Install the power supply.
Wear the anti-static wrist strap. Turn power supply circuit breaker to
OFF. Check the option switches on the power supply.

5 Install the fiber routing guide.
Mount the guide in the area below the circuit cards and secure with the
existing screws.

6 Connect the fiber optic cable or copper cable as applicable.
For the A0618443 cable, remove the two plugs on the Fiber Receiver
card. Connect the cable to the card so the “V” shaped groove is facing
inward. For the glass fiber optic cable, remove the plug on one connec-
tor on the card, and the cap on the cable. Insert the connector and
secure with a half turn clockwise. Wind the excess cable on the stor-
age device.

7 Insert the circuit cards in the expansion cabinet.
Refer to the following step action table “Install DMC8-Es” and your
work order for card placement.

8 Install or expand the MDF cross-connect terminal.
Consult your marked-up floor plan for the MDF addition location.

9 Install cables from the cabinet to the MDF cross-connect.
Consult your marked-up floor plan for the cable location.

10 Install PFTU and SDI cable if required.
Consult your marked-up floor plan for the cable location.

11 Replace the expansion cabinet drip tray.
Slide the drip tray inward.

12 Remove the main cabinet cover and drip tray.
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Table 11: Install additional Option 11 cabinets

Step Action

Undo the catches on the main cabinet and slide the drip tray outward.

13 Install a Fiber Routing guide in the main cabinet, if required.

The Fiber Routing guide is secured to the under side of the bottom
card rail and uses the screws to the left of the CPU card label and
under the card 2 label.

14 Turn the power supply circuit breaker to OFF.

15 Unseat the NTDK20 SSC card and install a Fiber Expansion daughter-
board.

Connect the Fiber Expansion daughterboard to the connector “Fiber 1”
if this is the first expansion cabinet, or to “Fiber 2” if this is the second
expansion cabinet.

16 Connect the fiber optic cable to the Fiber Expansion daughterboard.

For the A0618443 cable, remove the two plugs on the Fiber Receiver
card. Connect the cable to the card so the “V” shaped groove is facing
inward. For the glass fiber optic cable, remove the plug on one connec-
tor on the card and the cap on the cable. Insert the connector and
secure with a half turn clockwise. Wind the excess cable on the stor-
age device.

17 Re-seat the NTDK20 SCC card.

18 Route the fiber optic cable through the Fiber Routing Guide.

19 Set the circuit breaker in the main cabinet to ON.

The system will reload, then check time and date using LD2.

20 Reinstall the drip tray in the main cabinet.

21 Reinstall the main cabinet cover.
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Install IPE module wiring to the MDF

CAUTION: Service interruption

You can use the existing MDF cabling, however UTP Cat 5 —
NTCW15 or NTCW16 or NTCW17 MDF to PBX cabling is rec-
ommended as it provides a greater line length before signal
degradation occurs.

Figure 10: IPE I/O cable to BIX MDF termination
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pair 1—T T—pair 25
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NOTE

In NT8D11AC or NT8D11DC CE/PE and NT8D37AC or
NT8D37DC IPE modules, these BIX connectors are not used.
However, they are used in the NT8D11BC or NT8D11EC CE/PE
and NT8D37BA or NT8D37 EC IPE modules.
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Figure 11: IPE I/O cable to Krone MDF termination
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Consult your work order to determine the layout of the module 1/0
panel to MDF cabling route and perform the following steps:
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Table 12: Install IPE module wiring to the MDF

Step Action

1 Identify the UTP Cat 5 twenty-five pair MDF cable.

Label both ends of the cable with the IPE module number and the
I/O panel letter designation.

2 Connect the IPE or cabinet end of the cable.

Insert the cable’s Amphenol® connector into the appropriate
I/O panel connector. See Table 13 on page 39.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 10 on page 37 to locate the BIX connectors
and Table 13 on page 39 to locate the cable color code. For Krone MDF,
refer to Figure 11 on page 38 to locate the Krone connectors and Table 13
to locate the cable color code.

Table 13: Color code for 25 pair cable

Tip Ring
Amphenol pin number Body/Band Body/Band
26/1 White/Blue Blue/White
2712 White/Orange Orange/White
28/3 White/Green Green/White
29/4 White/Brown Brown/White
30/5 White/Slate Slate/White
31/6 Red/Blue Blue/Red
32/7 Red/Orange Orange/Red
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Table 13: Color code for 25 pair cable

Tip Ring

Amphenol pin number Body/Band Body/Band
33/8 Red/Green Green/Red
34/9 Red/Brown Brown/Red
35/10 Red/Slate Slate/Red
36/11 Black/Blue Blue/Black
37/12 Black/Orange Orange/Black
38/13 Black/Green Green/Black
39/14 Black/Brown Brown/Black
40/15 Black/Slate Slate/Black
41/16 Yellow/Blue Blue/Yellow
42/17 Yellow/Orange Orange/Yellow
43/18 Yellow/Green Green/Yellow
44/19 Yellow/Brown Brown/Yellow
45/20 Yellow/Slate Slate/Yellow
46/21 Violet/Blue Blue/Violet
47/22 Violet/Orange Orange/Violet
48/23 Violet/Green Green/Violet
49/24 Violet/Brown Brown/Violet
50/25 Violet/Slate Slate/Violet
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Install Option 11 cabinet wiring to the MDF

Consult your work order to determine the Option 11 cabinet to MDF
cabling route, and perform the following steps:

Figure 12: Option 11 MDF details

Main Cabinet MDF field
Cable J1

Cable J2
Cable J3
Cable J4
Cable J5
Cable J6
Cable J7
Cable J8
Cable J9
Cable J10

Expansion Cabinet MDF field Expansion Cabinet MDF field

| Cable J1 | | Cable J1 |
| Cable J2 | | Cable J2 |
| Cable J3 | | Cable J3 |
| Cable J4 | | Cable J4 |
| Cable J5 | | Cable J5 |
| Cable J6 | | Cable J6 |
| Cable J7 | | Cable J7 |
| Cable J8 | | Cable J8 |
| Cable J9 | | Cable J9 |
| Cable J10 | | Cable J10 |
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Table 14: Install Option 11 cabinet wiring to the MDF

Step Action

1 Identify the UTP Cat 5 twenty five pair MDF cable.

Label both ends of the cable with the cabinet jack number.

2 Connect the cabinet end of the cable.

Insert the cable’s Amphenol connector into the appropriate cabinet
connector jack.

3 Run the cable to the MDF.

4 Terminate the cable on the MDF.

For BIX MDF, refer to Figure 12 on page 41 to locate the BIX connectors
and Table 13 on page 39 to locate the cable color code.
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Install DMC8 and Faceplate Cables

This chapter contains the following topics:

Cross-connect base stations to the DMC8 positions. . ............. 43
Cross-connect base stations to the

DMCBRelay card .. ... oo 47
Install DMC8 and DMC8-E in an I PE shelf (Option51to81)....... 49
Install DMC8-Einan Option11cabinet . .. ..................... 52

Install faceplate cables and inter-shelf/cabinet cable

Cross-connect base stations to the DMCS8
positions

Consult your work order to determine the cross-connect details and
perform the following steps:

CAUTION: Service interruption

The jumper wire on the MDF must be at least UTP Cat 3. UTP
Cat 5 is recommended as it provides a greater line length
before signal degradation occurs.
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Table 15: Cross-connect base stations to the DMCS8 positions

Step Action

1 Cross-connect from the base station house side connector to the DMC8
equipment side connector.

Connect a jumper wire from the tip and ring of the house side connec-
tor to the tip and ring of the equipment side connector. Refer to Table 16
on page 44 for the tip and ring designators. For DMC8s type NTCWO0O0AB
and NTCWO1AB connect from base station 1 to base station 8.

Note: To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC)
IPE modules requires 24 tip and ring pair backplane to I/O panel
connections. To re-cable NT8D37 from 16 pair to 24 pair, see System
Installation Procedures (553-3001-210), Appendix C.

2 Cross-connect the remaining base stations.

Repeat step one until all base stations are cross-connected.

NOTE

The BIX tip and ring connections shown in Table 16 correspond
to standard BIX designation. The first pair are labeled TO and
RO. (See the Installation and Maintenance NTP, section Plan-
ning and Designating the MDF.)

Table 16: Base station tip and ring connections

. Base station MDF DMC8 MDF
Base station number . .
connection connection
Base station 1 T8 T8
Base station 1 R8 R8
Base station 1 T9 T9
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Table 16: Base station tip and ring connections

Base station MDF DMC8 MDF
connection connection

Base station number

Base station 1 R9 R9
Base station 2 T10 T10
Base station 2 R10 R10
Base station 2 T11 T11
Base station 2 R11 R11
Base station 3 T12 T12
Base station 3 R12 R12
Base station 3 T13 T13
Base station 3 R13 R13
Base station 4 T14 T14
Base station 4 R14 R14
Base station 4 T15 T15
Base station 4 R15 R15
Base station 5 T16 T16
Base station 5 R16 R16
Base station 5 T17 T17
Base station 5 R17 R17
Base station 6 T18 T18
Base station 6 R18 R18
Base station 6 T19 T19
Base station 6 R19 R19
Base station 7 T20 T20
Base station 7 R20 R20
Base station 7 T21 T21
Base station 7 R2 R21
Base station 8 T22 T22
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Table 16: Base station tip and ring connections

. Base station MDF DMC8 MDF
Base station number . .
connection connection
Base station 8 R22 R22
Base station 8 T23 T23
Base station 8 R23 R23
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Cross-connect base stations to the
DMC8 Relay card

Consult your work order to determine the cross-connect details and
perform the following steps:

Figure 13:
DMC8 Relay card to base station connections

Equipment side House side

7]

Base station

DMC8 Relay card

UTP CAT 5

MDF cable
P1 Backplane
connector
P2 MDE NTCW12DA
connector Ethernet cable
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Table 17: Cross-connect base stations to the DMCS8 positions

Step Action

1 Connect the NTCW12DA cable to the DMC8 Relay card.

Insert P1 into the DMC8 Relay card backplane connector located on
the Meridian 1 PBX shelf/module or the Option 11 cabinet.

2 Connect the MDF cable to the NTCW12DA cable.

Insert the MDF cable connector into P2.

3 Connect the MDF cable to the equipment side MDF cross-connect ter-
minal block.

See System Installation Procedures (553-3001-210) Cabling lines and
trunks or Option 11 Planning and Installation Guide (553-3021-210)
Installing and connecting cross-connect terminal to cabinets.

4 Cross-connect from the base station house-side connector to the
DMC8 Relay card equipment side connector.

Connect a jumper wire from the tip and ring of the house-side connec-
tor to the tip and ring of the equipment-side connector. Refer to Table 16
on page 44 for the tip and ring designators. For DMC8s type NTCWO0O0AB
and NTCWO1AB connect from base station 1 to base station 8.

To support base stations 5, 6, 7, and 8 on NT8D37 (AA and DC) IPE
modules requires 24 tip and ring pair backplane to I/O panel connec-
tions. To re-cable NT8D37 from 16 pair to 24 pair, see System Installa-
tion Procedures (553-3001-210), Appendix C.
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Install DMC8 and DMCS8-E in an IPE shelf
(Option 51 to 81)

Refer to your work order and marked-up floor plan to determine the
position of the DMC8 and DMC8-E and perform the following steps:

CAUTION: Electrostatic sensitive device

Wear a correctly connected antistatic wrist strap to handle cir-
cuit cards. Handle cards by the edges only. Do not touch the
contacts or components. Set the cards on a protective anti-
static bag, whenever possible. If an antistatic bag is not avail-
able, hand hold the card, or set it in a card cage removed from
the connectors.

CAUTION: Service interruption
Only install DMC8-Es in slot 8.

NOTE

The DMCs must be installed next to each other so the faceplate
cables connect to the ports.

o BB

NOTE

See the Meridian Companion DECT NTP Overview “System soft-
ware parameters” on page 38 for DMC8 and DMC8-E X11 Release and
software package compatibility.
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Figure 14: DMC8/DMCS8-E jumper details
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See page 53 for Option 11 card jumper settings.

CAUTION: Service interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9
are in the ETH position for operation on a dedicated LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9
are in the V.24 position for operation on a serial connection
to the OTM server.
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Table 18: Install DMC8 and DMCS8-E in an IPE shelf (Option 51 to 81)

Step Action

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre-Release 23 software strap A B. For post-Release 23 software,
and Multi-Site Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMCB8-Es for the system
type.

Strap A B for IPE shelf. (See page 53 for Option 11 settings.)

3 Install J3 jumper straps on the DMC8 and the DMC8-Es for cabinet or
IPE shelf number.

For shelf 0, the lower TN IPE shelf, strap B C. For shelf 1, the higher
TN IPE shelf, strap A B.

4 Install J6 to J9 jumper straps on the DMC8 and the DMCB8-Es used as
the Relay card for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position. For
the Ethernet connection strap jumpers J6 to J9 to the ETH position.

5 Insert DMCB8-E(s), if required.

Place DMCB8-E(s) in slot 8. See examples in Figure 16, Figure 17, Figure 18,
and Figure 19.

6 Insert DMC(s).

Place DMC8s in the slots as indicated on your work order. Do not place
DMCS8s in slot 8. See examples in Figure 16, Figure 17, Figure 18, and
Figure 19.
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Install DMCS8-E in an Option 11 cabinet

Consult your work order and marked-up floor plan to determine the
position of the DMC8 and DMC8-Es and perform the following steps:

CAUTION: Electrostatic sensitive device

Wear a properly connected antistatic wrist strap when handling
circuit cards. Handle cards by the edges only. Do not touch the
contacts or components. Set the cards on a protective anti-
static bag, whenever possible. If an antistatic bag is not avail-
able, hand hold the card, or set it in a card cage unseated from
the connectors.

CAUTION: Service interruption
Do not install DMC8-Es into any slot except slots 9, 19, or 29.

NOTE

The DMCs must be adjacent to each other so the faceplate
cables can be connected to the ports.

NOTE

See the Meridian Companion DECT NTP Overview “System soft-
ware parameters” on page 38 for DMC8 and DMC8-E X11 Release and

software package compatibility.

o BB
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Figure 15: DMC8/DMCS8-E jumper details

“HHEE We°°98°
o

g A
/ \
/ 0 O -- 0 \\
[ BERERE =3
o \
\
J
/
= /7

000¢ NON T¢ OTOW
areq uelS Auesem

553-A077.EPS

See page 50 for Option 51 to 81 card jumper settings.

CAUTION: Service interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9
are in the ETH position for operation on a dedicated LAN.

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9
are in the V.24 position for operation on a serial connection
to the OTM server.
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Table 19: Install DMC8-E in an Option 11 cabinet

Step Action

1 Install J1 jumper straps on the DMC8 and the DMC8-Es for Card ID.

For pre Release 23 software strap A B. For post Release 23 software,
and Multi-Site Mobility Networking, strap B C.

2 Install J2 jumper straps on the DMC8 and the DMCB8-Es for system
type.
Strap B C for Option 11. (See page 50 for Option 51 to 81 settings.)

3 Install J3 jumper straps on the DMC8 and the DMCB8-Es for shelf num-
ber.

For the lower TN cabinet, strap B C. For the higher TN cabinet,
strap A B.

4 Insert DMCB8-E(s), if required.

Place DMCB8-E(s) in slot 9, slot 19 or slot 29. See examples in Figure
20, Figure 21, Figure 22, and Figure 23.

5 Install J6 to J9 jumper straps on the DMC8 and the DMCB8-Es used as
the Relay card for either V.24 connection or Ethernet connection.

For the V.24 connection strap jumpers J6 to J9 to the V24 position.
For the Ethernet connection strap jumpers J6 to J9 to the ETH posi-
tion.

6 Insert DMC(s).

Place DMCS8s in the slots as indicated on your work order. Do not
place DMCS8s in slot 9, slot 19 or slot 29. See examples in Figure 20,
Figure 21, Figure 22, and Figure 23.
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Figure 16: Example of a full system housed in two IPE shelves
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Figure 17: Example of a 16 card system housed in two IPE shelves
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Figure 18: Example of a 17 card system housed in two IPE shelves
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Figure 19: Example of an eight card system housed in one IPE shelf
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Figure 20: Example of a full Option 11 system not using a CPU cabinet

i

(1A

I

il

UIURUBUUURUIUIUY|

% nnininiininininin

UIULUIUIUIC UV

553-8153.EPS

Meridian/Succession Companion DECT Installation Guide




Page 60 of 206 Install DMCS8 and Faceplate Cables

Figure 21: Example of a full Option 11 system using a CPU cabinet
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Figure 22: Example of an eight card system in two Opt 11 cabinets
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Figure 23: Example of an eight card system in one Opt 11 cabinet
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Install faceplate cables and inter-shelf/cabinet
cable

Consult your work order to determine the position of the faceplate
cable layout and NTCW11EA DMC8-E to DMC8-E inter-shelf cables and
perform the following steps:
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Figure 24:
NTCW11EA DMC8-E to DMCB8-E faceplate cable

Group of 20 Group of 10
ferrites ferrites

CAUTION: Service interruption

The NTCW11EA DMC8-E to DMC8-E faceplate cable has four sets of
movable ferrites. The position of the ferrites on the cable is
important. See Figure 24. Each end of the cable must have a group
of 20 ferrites. One quarter of the distance from each end of the
cable must have a group of 10 ferrites. The maximum length of the
cable is 1.5 meters, limiting the position of DECT shelves 0 and 1
to adjacent IPE modules or Option 11 cabinets.

Consult your work order to determine the position of the terminator
plugs and perform the following steps:
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Table 20: Install faceplate cables and inter-shelf/cabinet cable

Step Action

1 Connect the DMC8 to DMC8 faceplate cables.

Arrange the NTCW11AA DMC8 to DMC8 cables so that the DMC8 to
DMCS8-E cable is connected into the ports shown in Figures 16 to 18.

2 If required, connect the NTCW11BA DMC8 to DMC8-E cable on the IPE
shelf. Not required on Option 11.

Plug the cable into the lower port of the DMCS8 in slot 7. Plug the other
end of the cable into the arrow pointing left port of the DMCS8-E in slot
8. See Figure 16, Figure 17, and Figure 18.

3 Connect the NTCW11EA DMCB8-E to DMCB8-E inter-IPE shelf or
inter-cabinet cable, if required.

Plug the DMC8-E to DMCB8-E cable into each DMC8-E lower port.
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Install OTM DECT application

This chapter contains the following topics:

Ensure the DECT applicationisonthe OTM server . .............. 65
Ensure a communications profile is associated
with the DECT application . ............ ... ... 67
Add acommunications profile for the DECT application .. ...... 69
Addan Ethernetprofile......... ... . 71
NOTE

This Installation Guide assumes that an OTM server is installed
g on your Meridian 1 PBX or Option 11 PBX.

If the OTM is not installed, follow the instructions in the

Installing and Configuring Optivity Telephony Manager for Merid-

ian 1 (553-3001-230) NTP

Ensure the DECT application is on the OTM
server
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Figure 25:
Applications to Re-install
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Complete the following steps:

Ensure the DECT application is on the OTM server

Step Action

1 If there is a check in the DECT box in the Applications to Re-install dia-
log.
Go to “Configure the MDECT system on the OTM server” on page 73.

2 If there is no check in the DECT box in the Applications to Re-install
dialog.

Note: Installation is like any other application.

Select the check-box and click on the Next button.
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Ensure a communications profile is associated
with the DECT application
The DECT application must be associated with a communication

profile.
Figure 26:
Systems Properties - Applications
i Sample Site Samplc System System Properhics <]
| General | Communications | System Data Spplicativres I Cuzomers |
r— Application:
Eabled Mame Communication Fr..
Alarm M anagement S anmple Ethernet
v Call Tracking Sample Serial
Conzaolidatad Nepoits Systsm
- DECT S ample Etharnat
v [=1y] Sample Ethernet
Ger, Cusl Allc, Sy
- Maintenanse Windows Samnple Ethornct
v Statior AdminTPNCA st b anager Sannle Fthernat
v Systern Terminal [Overlay Passthn) Sample Ethernet
v Gystern Terminal (VT 220) Sampls Serial
T elecom Biling Susem
v Traffic Sample Serial

Delcted Application
v Enabled

Meme

Iﬂlarm t anagement

Communication Profile Frafile Type
I Sample Ethernet LI II— thermet

[k I Cancel Lpplie Help

The following describes the OK, Cancel, and Apply button actions:

e OK adds the changes you have made and returns to the previous
screen.

e Apply adds the changes and leaves the properties open so that
you can add other information to this properties dialog.

e Cancel closes the dialog box without adding the changes.
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Complete the following steps:

Table 21: Ensure a Communications Profile is associated with the DECT
application

Step Action

1 Open the Systems Properties sheet.

Choose Properties from the OTM Navigator window File menu.

2 Select the Applications tab.

Click on the Applications tab.

3 If there is a check in the Enabled column next to DECT in the Name
column.

Go to “Configure the MDECT system on the OTM server” on page 73.

4 If there is no check in the Enabled column next to DECT in the Name
column.

Highlight DECT in the name column.

5 Select a Communication Profile.

Choose any entry from the Communication Profile drop-down list.

Note: If there are no entries in the Communication Profile drop-down
list, go to “Add a communications profile for the DECT application” on page 69.

6 Accept the changes.

Click the OK button.
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Add a communications profile for the DECT application

Figure 27:
Add Communications Profile

Add Communications Profile

Profile Hame “
|New Ethernet

Cancel
Type Help

Senal

PPP

Complete the following steps:

Table 22: Add new Meridian 1 PBX communications profile

Step Action

1 In the Navigator window, select the Sample Site.

Double click on Sample Site.

2 Choose the Properties dialog.

Click on Properties from the File menu.

3 Open the Add Communications Profile dialog.

Click on the Communications tap and click Add.

4 Select a communications type.
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Table 22: Add new Meridian 1 PBX communications profile

Step Action

Highlight Ethernet in the Type box.

Note: The DECT application does not use the Communications Profile.
Unless there is another application that requires a specific
Communications Profile, choosing Ethernet is the least complicated
profile to implement.

5 Program the Profile Name.

Enter a Profile Name.

6 Accept the changes.
Click OK.
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Add an Ethernet profile

Figure 28:
System Properties - Communications
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Complete the following steps:

Table 23: Add your Meridian 1 PBX Ethernet profile

Step Action

1 Fill in the communications information for the Ethernet profile.

Enter any IP address.

Note: Unless there is another application that requires a specific IP
address, enter a non-existing address.

2 Accept changes.
Click Apply.
3 Return to configuring a communications profile.

Go to “Ensure a communications profile is associated with the DECT application” on
page 67.
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Configure the MDECT system on the
OTM server

This chapter contains the following topics:

Install the DME onthe DMC8relay card .. ... 74
Change the DM C8 Relay card default
IPaddress. .. ..o 76
Connect the DMC8 Relay card to aconfiguringPC . ............ 76
Reset the DMC8 Relay card default IP address to
your LAN IPaddress. .. ... 78
Connect the DMC8 Relay tothe OTM server . ... ... 80
Launchthe DECT application. . ..., 82
Addyour MDECT System . ... ..ot e 83
Add Generd System Properties. . .......... ... . .. 83
Set the MDECT system | P address to match
theDMC8Relaycard . . ... ...t 85
Add the upstream manager |IP address, if required . ............. 87
Synchronize datawith the MDECT system . ... ................ .. 89
Synchronize DECT PARIand SARI .. ........... .. ... ..... 21
Synchronize DECT Parameters. .. ..o, 92
Synchronize DECT Upstream Manager IPAddress. ............ 93
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Install the DME on the DMCS8 relay card

Figure 29:
NTCW25AA DECT Manager Ethernet (DME) daughterboard location
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Table 24: Install the DME on the DMCS8 relay card

Step Action

1 Unpack the NTCW25AA DECT Manager Ethernet (DME) daughterboard.

Remove the packing material.
2 Install the DME.

Carefully position the daughterboard over the four standoff posts and
press onto the DMCS8 relay card.
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Change the DMCS8 Relay card default

|IP address
Connect the DMCB8 Relay card to a configuring PC

CAUTION: Service interruption

The DMCS8 is shipped with a default IP address 192.168.1.1.
You must change the default address to conform to your
network IP address plan.

Figure 30:
NTCW12DA Ethernet cable to Configuring PC connections

DMC8 Relay card Configuring PC

P1 Shelf/Cabinet
Backplane connector Lo

MDECT System

P3 Ethernet
connector

RJ45

r/\
LT —

P2 MDF corinector NTCWI12DA Ethernet cable
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NOTE
The configuring PC can be the OTM server or another PC.

If your configuring PC is the OTM server, the Captive LAN shown
in Figure 30 will be the OTM Server Dedicated LAN shown in Fig-
ure 32 on page 80.

Consult your work order to determine the DMC8 Relay card location
and perform the following steps:

Table 25: Connect the DMC8 relay card to a configuring PC

Step Action

1 Connect the NTCW12DA cable to the DMC8 Relay card.

Insert P1 into the DMC8 Relay card backplane connector located on the
Meridian 1 PBX shelf/module or the Option 11 cabinet.

2 If your Configuring PC is on a Captive LAN, link the DMC8 Relay card
to your Configuring PC.

Insert P3 into the captive LAN RJ45 connector.

3 If your Configuring PC is on the OTM server dedicated LAN.

Insert P3 into the OTM server dedicated LAN RJ45 connector.See “Con-
nect the DMCB8 Relay to the OTM server” on page 80.
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Reset the DMC8 Relay card default IP address to
your LAN IP address

You must change the Relay DMC8 default IP address 192.168.1.1 to
conform to your server network IP address plan.

Figure 31:
Telnet 192.168.1.1

% Telnet - 192.168.1.104 M= E
Connect  Edit Terminal Help

login: dasuser

password:
local> ipconfig 192.168.1.184 255.255.255.0 192.168.1.199

Complete the following steps:

Table 26: Reset the Relay DMC8 default IP address to your LAN IP address

Step Action

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.
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Table 26: Reset the Relay DMC8 default IP address to your LAN IP address

Step Action

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the Relay DMC38
card address.

Enter the following command:
ipconfig XXX.XXX.XXX.XXX YYY.YYY.YYY.YYY 222.222.222.222

XXX.XXX.XXX.XXX = new IP address of the Relay DMC8 card.
YYY.YYY.yyy.yyy = subnet mask, usually 255.255.255.0

zzz.zzz.zzz.zzz = |P address if this is the gateway for your network.

Note: zzz.zzz.zzz.zzz should be setto the IP address of the OTM server
Ethernet interface. If you have two Ethernet interfaces on the OTM
server, zzz.zzz.zzz.zzz should be set to the IP address of the interface
which is on the same network as the DMC8 Relay card.
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Connect the DMCS8 Relay to the OTM server

Figure 32:
NTCW12DA Ethernet cable to OTM Server LAN connections

DMC8 Relay card MDF

DMCS8 Relay card
OTM Server

MDECT System

RJ45

RJ45

P3 Ethernet
connector

P1 Backplane
connector

P2 MDF NTCW12DA
connector Ethernet cable

Dedicated LAN
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Complete the following steps:

Table 27: Connect the DMCS8 relay card to a Captive LAN

Step Action

1 If your DMC8 was configured on a captive LAN, remove the NTCW12DA
Ethernet cable from the captive LAN.

Disconnect P3 from the captive LAN RJ45 connector.

2 Connect the NTCW12DA cable to the OTM Server Dedicated LAN.

Insert P3 into the Dedicated LAN RJ45 connector.
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Launch the DECT application

Figure 33:
M1 System Window

‘ Bl GalNoDECT - GAL1 - M1 System Window M=l E3
Filz View Maintenance Security  Utilitiez Window  Help

Telemanagement
[id ESH

Core Equipment
i | P stk

----- LOWP S wnchronization

| For Help. press F1 Mot connected 2

Complete the following steps:

Table 28: Launch the DECT application

Step Action

1 Launch the DECT application.

Double click on the DECT icon.
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Add your MDECT system
Add General System Properties

Figure 34:
DECT Systems and DECT System Properties
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Complete the following steps:

Table 29: Add your MDECT system

Step Action

1 Open the DECT System Properties dialog.

Pull down File>Properties.

2 Enter the MDECT system name.

Type your system name in the DECT System Name box.

Accept the changes.

Click on the Apply button.
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Set the MDECT system IP address to match
the DMC8 Relay card

Figure 35:
System Properties - Communication

Optivity Telephony Manager - DECT System Properties

General Sommunication ; Access Rightldentiﬂcatinn; Alarml Parameters;

IP address: |

Subnetwork Mask: ]

Gateway [P Address: ]

Fermanent Connection [ Elmse EoRRecinn

" Serial

Ok I Cancel i Apply i Help i
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Complete the following steps:

Table 30: Set your IP address of the DMC8 Relay card in the manager

Step Action

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address you entered in Table 26 on page 78.

3 If your communication link is Ethernet, select Ethernet.

Click on the Ethernet radio button.

4 If your communication link is Serial, select Serial.

Click on Serial radio button, and go to “Add a V.24 serial connection” on
page 139.

5 Accept the changes.

Click on the OK button.

Note: When you click the OK button or Apply button at this point, the
manager attempts to connect to the MDECT system to write the MIB2
system name.

6 If required, program an Upstream Manager.

Go to page 87.

7 If you do not require an Upstream Manager.

Go to page 89.
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Add the upstream manager IP address, if required

Figure 36:
System Properties - Alarm

Optivity Telephony Manager - DECT System Properties

General] Cnmmunicatinn] Access Right Identification Alarm l Parameters]

Alarm Active: |

Upstream Manager IP address: |

Date: |

Tirne: |

Cancel ‘ Apply ‘ Help |

Complete the following steps:

Table 31: Add the upstream IP address, if required

Step Action

1 Open the DECT System Properties dialog.

Pull down File>Add.

2 Open the Alarm dialog.

Meridian/Succession Companion DECT Installation Guide




Page 88 of 206 Configure the MDECT system on the OTM server

Table 31: Add the upstream IP address, if required

Step Action

Click on the Alarm tab.

3 Enter the IP address.

Type your Upstream manager |IP address.

4 Accept the changes.
Click on the OK button.
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Synchronize data with the MDECT system

When your DECT manager connects to the MDECT system,
synchronization occurs. Synchronization compares the database on
your manager to that of the MDECT system. Database mismatches are
flagged by dialogs. You then have the opportunity to change either
the MDECT system data or the manager data.

Figure 37:
DECT Systems

H=f] 0 ptivity Telephony Manager - Sample Site - Sample System - DECT Systems

File  Wiew Applicalions  Firreare  Wirdews  Hep

g
++

& TisMerdignualy € AIDECT Syslzris

Siie | Werdan | JECT Systern | Alarm | 1P Address AR Concentration | Mumaer of Users | Connectaon
192.168.1.1

0| Connzclod

Connzcted
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Complete the following steps:

Table 32: Synchronize data with the MDECT system

Step Action

1 If the toolbar icon is red your already connected to the MDECT system.
Disconnect from the MDECT system.

Double click on the icon, or use File>Disonnect.
Go to step 3.

2 If the toolbar icon is green.

Go to the next step.

3 Re-connect to the MDECT system.

Double click on the red icon, or use File>Connect.
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Synchronize DECT PARI and SARI

Figure 38:
Synchronize DECT PARI and SARI Mismatch dialog

E%‘:Dplivity Telephony Manager - Synchronize DECT PARI and 5A...

The PARI and SARI an the DECT System changed.
Changing the PAR] and SARI stops and restarts the DECT System.

gParameters onthe DECT Systemg Parameters on the DECT Manager]

FPARI |FES43210
SARI |01234567

Update DECT Manager | Update DECT System | Help |

Complete the following steps:

Table 33: Synchronize DECT PARI and SARI

Step Action

1 Store the MDECT system PARI SARI parameters in the OTM Manager
database.

Click on the Update DECT Manager button.
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Synchronize DECT Parameters

Figure 39:
Synchronize DECT Parameters Mismatch dialog

o Dptiwity Telephony Manager - Spnchromize DECT Parameters El
The Parameiers an e DECT System changaed

Tang Duralicn () 100 _""I
Inber Ciiga Paiss e {mz); 100 =
Pausa Duraon (ms); £4.4 Ll
Ll 1 - lorey drequancy (dB) 13,06 _"I
Lerwid 2 - i frequericy (dB) -11.06 =]
A Dl Fad - andset o svstem dB): U Il
8 O loss Fad - system 1o handset ey O _"

Updaie DECT Manager Updale DECT Eystem | Help |

Complete the following steps:

Table 34: Synchronize DECT Parameters

Step Action

1 Store the MDECT system DECT parameters in the OTM Manager data-
base.

Click on the Update DECT Manager button.
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Synchronize DECT Upstream Manager IP Address

Figure 40:
Synchronize DECT upstream manager IP address mismatch dialog

Eg’,i'l]ptivity Telephony Manager - Spnchronize DECT upstream manag...

The IP Address of the Upstream Manager on the DECT System changed.
Address on the DECT System: 1921.1.4

Address onthe DECT Manager, 192.2.3.4

UpdateDECTManagerE Lipdate DECT System | Help ‘

Complete the following steps:

Table 35: Synchronize DECT Upstream Manager IP Address

Step Action

1 Store the MDECT system upstream manager |IP address in the OTM
Manager database.

Click on the Update DECT Manager button.
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Configure handsets and retrieve
subscription data

This chapter contains the following topics:

Configure non-concentrated handsetson aMeridian 1 PBX . ........ 96
Open Station Administrationwindow . .. ..................... 96
AccessAdd Stationdialog. . ... 97
Add500analogstandard . .. ....... ... 98
ACCESSTEAIUNES . . .. oo 99
ACCESSWITEIESStYPE . . .ttt 100
Select wirelesstype. .. ..o 101
Select DECT wirdlessset .. ..o e 102
Acceptchanges. . ... 103

Configure concentrated handsetson aMeridian 1PBX .. .......... 104
Open Station Administrationwindow . .. ..................... 104
AccessAdd Stationdialog. . ... 105
Select Digital CordlessSet .. ... 106
SeleCt FeatUreS . .. .. oo 107
Select wirelesstype . .. ..o 108
Select Visitorlocal ........... 109
Selectanindex .. ... 110
Provisonhardware. . . ... 111
Acceptchanges. . . ... 112
Singlelinefeatures. . ......... . 113

Retrieve subscription datafor handsets. .. ...................... 115
Enable subscription. ... 117
Activatethe PIN onthehandsets. . ......................... 118
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Configure non-concentrated handsets on a
Meridian 1 PBX

For information about System Administration, see Using Optivity
Telephony Manager for Meridian 1 (553-3001-330)

Open Station Administration window

Figure 41:
M1 System Window

Bl Sampl= Site - Sample Syetem - M1 Syztem Wind . W= E
e Yew Marlensrce Seomty  Lilbes Window Help
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= ESH
I Cose Equipmen
g Lo FL
E 14D Protz
B Metvacik Giroups
EI Fsbyaork Loops
[l FE Shebves
[E PE Card:
T

-

Table 36: Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M1 System Window.
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Access Add Station dialog

Figure 42:
Station Administration window
| = S ample Site - Sample System - Station Adminiztation
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Table 37: Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.
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Add 500 analog standard

Figure 43:
Add Station dialog
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Table 38: Add 500 analog standard

Step Action

1 Add 500 analog standard.
Highlight 500 Analog Standard, and click OK.
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Access features

Figure 44:
500 dialog
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Figure 45: Access features

Step Action

1 Access features.

Click on the Features button.
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Access wireless type

Figure 46:
Features dialog
Features
TIMP Termination Impedance for X0P5 units i
TH Terminal MNumber L.%EEPL..;
TSA Three Party Service
TVA Trunk Yerification from Station Done i
ULAA Set Based User Level Access
USMA Meridian 911 pozition
USRA User Selectable Call Redirection Help i
WwWRLS Wireless
WTA Warning Tone
WP Wirelezs Tppe =
¥FA Call Transfer or Attendant Recall
x?m Fserluzive Hold AJ:J
1 | ’
- Search by
{* Features
' Feature Group

Table 39: Access wireless type

Step Action

1 Access wireless type.

Highlight Wireless Type, and click on the Select button.
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Select wireless type

Figure 47:
Wireless dialog

Call Parly Nams Dizplay [CHDA] | Dansed =|

‘Wueless [WHALS] Yoz j
Wirelesz Tepe PWTYP) Mo

© 0k | concel | Hew |

Table 40: Select wireless type

Step Action

1 Select wireless type.

From the Wireless Type (WTYP) pull-down menu, click on YES.
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Select DECT wireless set

Figure 48:
Wireless dialog

Call Party Hame Display [CHDWM) |Dcr|lc|:l :l
Wireless [WRLS) [Yes d

Wireless Type (W TYP) |DECT Wireless Sl

Table 41: Select DECT wireless set

Step Action

1 Select DECT handset.

From the Wireless Type (WTYP) pull-down menu, click on DECT Wire-
less Set, and click on the OK button.
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Accept changes

Figure 49:
Features dialog
Features
TIMP Termination Impedance for X0P5 units i
TH Terminal Humber L.%EEPL..;
TSA Three Party Service
TVA Trunk Yerification from Station Done i
ULAA Set Based User Level Access
USMA Meridian 911 pozition
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WAHLS Wireless
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WIYP Wireless Tupe =
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1 | ’
- Search by
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' Feature Group

Table 42: Accept changes

Step Action

1 Accept changes.

Click on the Done button.

Meridian/Succession Companion DECT Installation Guide



Page 104 of 206 Configure handsets and retrieve subscription data

Configure concentrated handsets on a
Meridian 1 PBX

Open Station Administration window

Figure 50:
M1 System Window
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Table 43: Station Administration window

Step Action

1 Open the Station Administration window.

Click on Station Administration in the M1 System Window.
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Access Add Station dialog

Figure 51:
Station Administration window
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Table 44: Access Add Station dialog

Step Action

1 Access Add Station dialog.

From the Edit pull-down menu, click on Add.
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Select Digital Cordless Set

Figure 52:
Add Station dialog

Add Station
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Table 45: Select Digital Cordless Set
Step Action

1 Select Digital Cordless Set.

Highlight DCS, and click on the OK button.
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Select Features

Figure 53:
DCS dialog
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Table 46: Select Features

Step Action

(IR

Select features.

Click on the Features button.
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Select wireless type

Figure 54:
Features dialog
Features
TVA Trunk ¥erfication from Station - T Pl S
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Table 47: Select wireless type

Step Action

1 Select wireless type.

Highlight WTYP, and click on the Select button.
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Select Visit or local

Figure 55:
Wireless dialog
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Table 48: Select Visit or local

Step Action

1 Select Visit if this handset is to visit this Meridian 1 PBX. Select local if
this handset is configured on this Meridian 1 PBX.

If Visit, go to step 2. If local, go to step 4.

2 Select visit.

From the Visiting DECT Set (VSIT) list, select Yes.

3 Select a Home DN.

Enter a DN in the Home Directory Number (HMDN) box.

4 Select local.

From the Visiting DECT Set (VSIT) list, select No.

5 Accept changes.

Click on the OK button.
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Select an index

Figure 56:
Features dialog
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Table 49: Select an index

Step Action

1 Select an index.

Highlight INDX, and click on the Select button.
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Provision hardware

Figure 57:
Hardware Provisioning dialog
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Table 50: Provision hardware

Step Action

1 Select a DMC TN.

Enter a TN in the DECT Mobility Controller (DMC) box.

2 Select an index.

Enter an index in the Index on DMC (INDX) box.
(Index range is 0 to 509.)

Note: The Terminal Number (TN) is a virtual TN and is selected by the
Meridian 1 PBX system.

3 Accept changes.

Click on the OK button.
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Accept changes

Figure 58:
Features dialog

Features
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Table 51: Accept changes

Step Action

1 Accept changes.

Click on the Done button.
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Single line features

Figure 59:
500 dialog
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Table 52: Single line features

Step Action

1 For other single line features.

Refer to the OTM Station Administration in Using Optivity Telephony Man-
ager for Meridian 1 (553-3001-330).
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NOTE

Complete the Meridian 1 COMPANION Programming record
(553-3601-250).
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Retrieve subscription data for handsets

Figure 60:
DECT Systems window and Subscriptions window
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Complete the following steps:

Table 53: Subscribe handsets

Step Action

1 Launch the Subscriptions window from the DECT Systems window.

Click on the Applications pull-down menu, click on Subscriptions.

2 Retrieve the subscription configuration data from the OTM Station
Administration database.

Note: At this point, there is no handset data shown in the Subscriptions
window.

In the Subscriptions window, click on the Operations pull-down menu,
click on Retrieve OTM Configuration.

3 Note: At this point, all handsets configured on OTM Station
Administration are shown in the Subscriptions window

Open the Configure DECT Subscription dialog.

Click on the File pull-down menu, click on Add or click on =1
o
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Enable subscription

Figure 61:
Subscriptions window

E_zal]plivily Telephony Manager - GalMoDELCT - GALT - DMC8-1 - Subscriphions

File Wiewy Edit Qrerations Help

W Show Available Show Subscribed

DME |00 8 'I

w Show Enabled  w Show Black Listed

DMC TH | Index| Home DR | Local O | Home | ¥T PARK Status Fir Carnment
0o 8 1 16634213 [Availahle
Disconnected Subscription PARK:1 6634213

Complete the following steps for each handset:

Table 54: Configure handsets

Step Action

1 Note: At this point, there are no PINs shown in the Subscriptions
window.

Select a handset from the list.

Click on one handset in the list to highlight a row.

2 Enable handsets.

Click on the Operations pull-down menu, click on Enable or click on
=
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Activate the PIN on the handsets

Figure 62:
Subscriptions window

E_zal]plivily Telephony Manager - GalMoDELCT - GALT - DMC8-1 - Subscriphions

File Wiewy Edit Qrerations Help
| v | v | =]
v Show Available Show Subscribed

DME |00 8 'I

w Show Enabled  w Show Black Listed

DMC TH | Index| Home DR | Local O | Home | ¥T PARK Status Fir Carnment
0o & 1 16634213 |[Enabled  |65831
Disconnected Subscription PARK:1 6634213

Complete the following steps:

Table 55: Obtain the PIN

Step Action

3 Note: At this point, in the Subscriptions window, the PINs are shown
and the Status is Enabled.

Subscribe the C4010, C4010Ex, C4040, and C4050 handsets.

See “C4010, C4010 Ex, C4020 handset subscription” on page 120, and “C4050
handset subscription” on page 127.

NOTE
When a handset is subscribed, the Subscription window shows the
Status column as Subscribed and does not show a PIN.
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Handset subscription

This chapter contains the following topics:

C4010, C4010 Ex, C4020 handset subscription.. ................ 120
Distribute C4010, C4010 Ex, C4020 handsets and install
battery chargers. . ... .o 120
Subscribe the C4010, C4010 Ex, C4020 handset . . .. ........... 123
C4050 handset subscription . .. ... 127
Distribute C4050 handsets and install battery chargers. . ........ 127
Subscribethe C4050 handset . . . ... 129
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C4010, C4010 Ex, C4020 handset subscription

Figure 63: C4010 handset and C4010 Ex handset

KEN SPINK KENT WARD

PLNR Menu4 PLNR Menud

Distribute C4010, C4010 Ex, C4020 handsets and install
battery chargers

Consult your work order for a list of handset users and their
locations.

DANGER: Serious injury
Never charge a C4010 Ex battery in an explosive atmosphere.

553-3601-203 Standard 5.00 June 2001



Handset subscription Page 121 of 206

Figure 64: Battery details, charger details, and connections
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Table 56: Install battery charger and charge batteries

Step Action
1 Take the handset package to the user location.
2 Unpack the handset and its accessories, as applicable.
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Table 56: Install battery charger and charge batteries

Step Action

3 Insert the handset battery pack, as applicable.
Note: Use only the approved battery for the C4010 Ex handset.

4 Unpack the handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk, or mount the charger on the wall,
as applicable.

Note: Never mount a battery charger in an explosive atmosphere.

6 Install the mounting screws. Use screws with a maximum diameter of
4 mm.

Turn the two screws into the wall at a distance of 45 mm from each
other. Make sure that the screw heads protrude by 2.5 to 3 mm.

7 Hang the charger on the screws.

8 Install the power supply.

Plug the power supply cable into the connector located on the side of
the charger, then plug the ac adapter into the 230 V ac mains socket.

9 Place the handset into the charger.

Note: The battery icon appears on the display indicating the battery is
charging, if the battery is installed or not.
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CAUTION: Service interruption

Charge the C4010, C4010 Ex, C4020 battery at least 12 hours
before using the handset for the first time. This will lengthen
the service life of the battery.

Subscribe the C4010, C4010 Ex, C4020 handset

Consult the work order for a list of subscription names.

Table 57: C4010, C4010 Ex, C4020 handset subscription

Select Language.

Select Declare base.

Press the Declare base key.

Declare base number? 12345678.

Press the Ok key.

Enter code refers to the PIN code.

Note: The Subscriptions screen displays the PIN. The PIN is only valid
for 16 minutes.

Enter the PIN.

To delete the last digit you entered, press Erase or select the digit and
enter a new digit.

Press the Ok key.
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Table 58: Handset name and DN identity

Step Action

5 Select Menu.

Press the Menu Kkey.

6 Select Handset name.

Dial 86.

7 Enter the Handset name and/or the handset DN to identify the hand-
set.

To enter a character, press keys 0 to 9 as shown in Table 59. For exam-
ple to enter E press key 3 twice. To move to the next character, pause
three seconds. To delete a character, press Erase or select the digit
and enter a new digit.

Note: Handset DNs are programed in LD 10, not in the DECT database.

8 Confirm the name and DN.

Press the Ok key.
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Table 59: Southern handset key pad alphabet equivalent

e English
« French

¢ German

e Dutch
e Spanish
e ltalian
Key 1 2 3 4 5 6 7 8 9
0 0
1 - / space 1 : : °
2 A B C 2 A A K3
3 D E F 3 E E
4 G H I 4 | |
5 J K L 5
6 M N o) 6 N o) o 0
7 P Q R S 7
8 T U v 8 U U
9 W X Y z 9
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Table 60: Northern handset key pad alphabet equivalent
e English
e Portuguese

¢ Swedish

* Norwegian

* Finnish
e Danish
Key 1 2 3 4 5 6
0 0
1 - / space 1 ,
2 A B C 2 A A
3 D E F 3 E
4 G H | 4
5 J K L 5
6 M N o) 6 ¢ ¢ ¢
7 P Q R S 7
8 T U v 8 U
9 W X Y z 9
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C4050 handset subscription

Figure 65: C4050 handset

553-A0079

Distribute C4050 handsets and install battery chargers

Consult your work order for a list of handset users and their
locations.
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Figure 66: Battery details, charger details, and connections
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Table 61: Install battery charger and charge batteries

Step Action

1 Take the handset package to the user location.
2 Unpack the handset and its accessories, as applicable.
3 Insert the handset battery pack, as applicable.

Note: Use only the approved battery for the C4050 handset.

4 Unpack the handset battery charger and its accessories.

5 Mount the battery charger.

Place the charger on the desk.
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Table 61: Install battery charger and charge batteries

Step Action

6 Install the power supply.

Plug the power supply cable into the connector located on the side of
the charger, then plug the ac adapter into the 230 V ac mains socket.

7 Place the handset into the charger.

Note: The LED ring on the handset shows green when the batteries are
charging.

(H

CAUTION: Service interruption

Charge the C4050 battery at least eight hours before using the
handset for the first time. This will lengthen the service life of
the battery.

Subscribe the C4050 handset

Consult the work order for a list of subscription names.

Table 62: C4050 handset subscription

Step Action

1 Select Menu.

Press Menu.

2 Select System.

Scroll to System. Press OK.
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Table 62: C4050 handset subscription

Step Action

3 Select Subscription.
Press OK.

4 Select Options.
Scroll to New. Press OK.

5 Enter PARK if two DECT systems overlap.
Press OK.

6 Enter the PIN code.
Note: The Subscriptions window displays the PIN. The PIN is only valid
for 15 minutes.
Enter the PIN code.

7 Enter the system name.

8 Enter the handset DN.

9 Enter the handset users name.
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Table 63: Handset key pad alphabet equivalent

Key 1 2 3 4 5 6 7 8 9 10 11
0 0 space | @ $ &

1 1 ? ! , ; “ ‘

2 A B C 2 A A £ c
3 D E F 3 E E E E

4 G H | 4 | | ] |

5 J K L 5

6 M N 0 6 N o) 0 o 0 0 @
7 P Q R S 7

8 T U \Y 8 U U U U

9 W X Y z 9

w & - + = ~ < > R %

# # ( ) { } [ ] / \ _
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Base Station Power and Muting

This chapter contains the following topics:

Open RFPWINOW . .. . ..o e 134
Set alarm muting, line power, and comments
for Base StationS. .. ... oo 136
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Open RFP window

Figure 67:
DECT Systems main window and RFP window
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Complete the following steps:

Table 64: Open RFP window

Step Action

1 Launch the DECT Systems window.

2 Launch the Boards window.
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Table 64: Open RFP window

Step Action

On the DECT Systems window, click on the Applications pull-down
menu, click on Boards.

3 Select a base station from the list.

Click on one RFP in the list to highlight a row.

4 Open the Radio Fixed Part properties dialog.

Click on the Eile pull-down menu, click on Properties.
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Set alarm muting, line power, and comments
for Base Stations

Figure 68:
DECT Radio Fixed Parts

E‘r’iﬂplivity Telephony Manager - DECT Radio Fixed Parts___
DMC TH: 011 03
Radio Identifier: E
Mumber of Channels: ‘1 2
Operational Btatus: ‘Operatiunal
Alarm mluted: Ho LI
Carmrmert bl bia
Line Powered ©  Local Powered

oK ‘ Cancel ‘ Apply ‘ Help ‘

Complete the following steps:

Table 65: Set alarm muting, line power, and comments for Base Stations

Step Action

1 Set alarm muting.Select No to deny alarm muting or Yes to allow alarm
muting.

Click on No or Yes.

2 Enter up to 80 characters for comments.

553-3601-203 Standard 5.00 June 2001




Base Station Power and Muting Page 137 of 206

Table 65: Set alarm muting, line power, and comments for Base Stations

Step Action

Type comments.

3 Select local powered or line powered for the selected base station.

Click the Line Powered or Local Powered radio button.

4 Apply the selections.
Click the OK button.
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Add a V.24 serial connection

This chapter contains the following topics:

DMCB8to OTM server serial connections. . ..............cou.... 140
Connect therelay cardtoalocal OTM server . ................... 141
Connect the relay card to aremote OTM server with modems. ... . ... 143
Install avirtual modemonyourPC........... ... ... 146
Configure modem properties. ... ... e 148
Setmodemspeed . .. ..o 150
Set connection preferences. . ... 152
Disableflow control .. ...... ... ... . ... . . . 154
Configure Remote Access Service (RAS) . .. oo oot 155
Set RASmodemand portusage. . ... .ovvvii i 157
Configure RASsetupandnetwork . . .......... ..., 158
Configure RAS SEIVICES . . . oo vttt 160
Set up and configureaRAS Phonebook entry .. ................. 162
Open the Dial-up Networking dialog . . ...................... 162
Set upthe phonebook entryname.. ......... ... ... ... ...... 163
Setuptheserverdialog. .. ... 164
Gotothenextdidog. ..........oiiiiii 165
Setupcomplete. .. ... 166
Configure the networkingdial-up . ............ ... . ... ... 167
Configurethe Did usingentry .. .......... i, 168
Configurethe Did-up servertype. ..., 169
ConfigurelPaddress. .. ... 170
Accept the configurationchanges. .. .............. ... ... .. 172
Establishthe RAS connection . ............ ... ..., 173
Establish aconnectiontothe DECT system ... ................ 174
Establish connectioncomplete. . .......... ... ... . ... .. 175
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Set the P addressthrough Telnet .. . ............. ... ... ... 176
ConfigurethelPaddress. .......... ..o 177
Hang-upthe RASconnection . . ........... .o .. 178

DMC8 to OTM server serial connections

A DMC8 relay card to OTM server serial connection is required if a
DME daughterboard is not present on the relay card. There are two
types of serial connection:

e when the relay card and OTM server are local, connected without
a modem

 when the relay card and OTM server are remote, connected with
a modem

CAUTION: Service interruption

Ensure that the DMC8/DMC8-E Relay card jumpers J6 to J9
are in the V.24 position for operation on a serial connection
to the OTM server.
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Connect the relay card to a local OTM server

Figure 69: DMCS8 relay card connection to alocal OTM server

DMCS8 Relay card
without NTCW25AA
DME daughterboard

OTM Server

~_

IR

NTCWI12AA A0773252 Standard

MDF to modem Null modem DB-25 to DB-9
' ' ' ' " 'w cable adaptor cable

Table 66: Connect the relay card to a local OTM server

Step Action

1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.

Refer to Table 67 on page 142 for the NTCW12AA cable tip and ring con-
nections.
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Table 66: Connect the relay card to a local OTM server

Step Action

2 Choose the OTM server COM port from your work order.

Connect the DB-9 cable connector into the OTM COM port.

3 Install the null modem plug.

Connect the DB-25 connector end and the NTCW12AA cable end into
the AO773252 null modem adapter.

NOTE

The BIX tip and ring connections shown in Table 67 on page 142
correspond to standard BIX designation. The first pair are
labeled TO and RO. (See the Installation and Maintenance NTP,
section Planning and Designating the MDF.)

Table 67: NTCW12AA cable to MDF connections

DMC8 Relay card DB25 connector Signal
. Cable color . .

MDF connection pin number designator
T1 Grey 8 V.24DCD
R2 Yellow 4 V.24RTS
T3 Blue 2 V.24TXD
R3 Red 3 V.24RXD
T4 Pink 7 V.24GND
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Connect therelay card to aremote OTM server
with modems

Figure 70: DMCS8 relay card connection to aremote OTM server

DMCS8 Relay card
without NTCW25AA
DME daughterboard

OTM Server
Modem

P

Standard
NTCW12AA DB-25 to DB-9
MDF to modem cable

poooooonn, e
PSTN )

Table 68: Connect the remote OTM server to a modem

Step Action

1 Connect the OTM COM port to the modem.

Connect the DB-9 end of the V.24 cable to the OTM COM port. Connect
the DB-25 end of the V.24 cable to the modem.
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Table 68: Connect the remote OTM server to a modem

Step

Action

2

Set up the OTM modem.

Follow the manufacturers set-up procedures. Set modem as follows:
e Line speed = 38400b/s

e No parity

« 1 stop bit

e 8 bit words

« No output control

* No timer

Connect the modem to the Public Switched Telephone Network.

Plug a teledapt cable into the modem RJ11 jack. Connect the other end
of the teledapt cable to the PSTN.

(H

Table 69: Connect the DMC8 Relay card to a modem

Step Action
1 Connect the NTCW12AA cable to the DMC8 Relay card MDF connector.
Refer to Table 67 on page 142 for the NTCW12AA cable tip and ring con-
nections.
2 Set up the OTM modem.
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Table 69: Connect the DMC8 Relay card to a modem

Step Action

Follow the manufacturers set-up procedures. Set modem as follows:
e Line speed = 38400b/s

e No parity

*« 1 stop bit

e 8 bit words

« No output control

« No timer

3 Connect the NTCW12AA cable to the modem.

4 Connect the OTM modem to the Public Switched Telephone Network.

Plug a teledapt cable into the modem RJ11 jack. Connect the other end
of the teledapt cable to the PSTN.
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Install a virtual modem on your PC

This task is only required if there is no Ethernet connectivity to the
relay card.

Figure 71:
Install New Modem

Install Hew Modem B
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Have Dizk... |
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Complete the following steps:

Table 70: Install a modem on your PC

Step Action

1 Go to Control Panel.

Click on Modem.

2 Manufactures.

Select [Standard Modem Types].
3 Models.

Select Dial-Up Networking Serial Cable between 2 PCs.

4 Continue.

Click on Next.
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Configure modem properties
The properties must be configured to interface serially to the MDECT

system.
Figure 72:
Modem Properties
Modems Properties EE
Genelall

@ The follawing moders are set up on this computer:

rdoderm | Alta
%:,] Dial-Up Metwarking Serial Cable between 2 PCs #3 COb

Add... Remove

— Dialing Preferences

Dialing fram:  Mew Lozation

Iz Dialing Properties to modify how pour calls ans
dialed.

Dialing Properties |

Cloze | [Earize]
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Complete the following steps:

Table 71: Configure modem properties

Step Action

1 Go to Control Panel.

Click on Modem.

2 Select the modem installed.

Click on the modem in the list.

3 Open the properties dialog.

Click the Properties button.
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Set modem speed

Figure 73:
Dial-Up Networking Serial Cable between 2PCs #... General

Dial-Up Networking Serial Cable between 2 PCs #._. Ed B4

Gieneral | Connection |
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Complete the following steps:

Table 72: Set modem speed

Step Action

1 Select maximum modem speed.

Choose 38400.

2 Apply selection.
Click the OK button.
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Set connection preferences

Figure 74:
Dial-Up Networking Serial Cable between 2PCs #... Connection tab

Dial-Up Metworking Serial Cable between 2 PCs #.._ [E B3

General Connection |

— Connection preferences

Data bits: IS 'I
Parity: INone "I
Stop bitg: |1 "I
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[T Dizzannect a call it idle for mare thar I ming

(] Cancel
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Complete the following steps:

Table 73: Set connection preferences

Step Action

1 Set Data bits.

Select 8.

2 Set Parity.

Select None.

3 Set Stop bits
Select 1.

4 Open Advanced dialog.

Click on the Advanced button.
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Disable flow control

Figure 75:
Advanced Connection Settings

Advanced Connection Settings

-
-
-
-

| E
E stra zeftings

[~ Record a log file

aF. | Cancel

Complete the following steps:

Table 74: Disable flow control

Step Action

1 Ensure that flow control is disabled.

Remove check from the Use flow control box.
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Configure Remote Access Service (RAS)

Figure 76:
Network - Services
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Complete the following steps:

Table 75: Configure Remote Access Service

Step Action

1 Open the Network property dialog.

Start> Control Panel> click on the network icon.

2 Select Services.

Click on Services tab.

3 Select the Remote Access Service.

Click on Remote Access Service.
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Set RAS modem and port usage

Figure 77:
Remote Access Setup and Configure Port Usage
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Complete the following steps:

Table 76: Set modem and port usage

Step Action

1 Select a modem.

Highlight a device.

2 Configure.

Click on the Configure... button.

3 Select Port Usage.

Click on the Dial out only radio button.
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Configure RAS setup and network

Figure 78:
Remote Access Setup and Network Configuration

i Remote Access Setup |
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Complete the following steps:

Table 77: Configure Remote Access Service

Step Action

1 Select a modem.

Highlight a device.

2 Select Network.

Click on the Network button.

3 Select TCP/IP protocol for this port.
Click a check in the TCP/IP box.
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Configure RAS services
NetBios Interface Service must be installed, or there are no PPP
protocols configured on the RAS ports.

Figure 79:
Network - Services
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Complete the following steps:

Table 78: Configure Remote Access Service

Step Action

1 If the NetBios Interface Service is not installed.
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Set up and configure a RAS Phone book entry
Open the Dial-up Networking dialog

Figure 80:
Dial-up Networking dialog

al-Up Metworking

FPhonebook entry to dial:

] [
Hew tore = i

Fhone number prewvies:

i

Dialirg fram:

]New Location :__'_j

Location... ;

Dl | Close |

Complete the following steps:

Table 79: Open the Dial-up Networking dialog

Step Action

1 Open the Dial-up Networking property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Continue.

Press the New button.
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Set up the phone book entry name

Figure 81:
New Phonebook Entry Wizard

MHew Phonebook Entry Wizard

Diallp Metworking connects you to remote networks
uzing pour modem, ISOM, or other 'WAN adapter, Thiz
wizard helps vou create a phonebook entry that stares
the settings needed to connect to a particular remate
nietwacrks.

Marne the new phonebook entry:

[My DECT System

I | know all sbout phonebook entries and
would rather edit the properties directy

< Back I Mest > I Cancel

Complete the following steps:

Table 80: Set up the phone book entry name

Step Action

1 Name the phone book entry.

Enter your system name.

2 Accept the changes.

Press the Next button.
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Set up the server dialog

Figure 82:
Server

Check all that apply:

™ | am calling the Intermet.

Iv iSend my plain text passward if that's the only way
o connect.

[~ The nonwindows MT zerver | am calling expects
e ba bpe login information after connecting, or bo
knowe TCPAP addreszes before dialing.

< Back I Mext » I Cancel

Complete the following steps:

Table 81: Configure Remote Access Service

Step Action

1 Set up the server dialog.

Check the Send my plain text password... box.

2 Accept the changes.

Press the Next button.
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Go to the next dialog

Figure 83:
Phone Number

Phone Number

Enter the phone number of the dial-up server you are
caling. Alternate phone numbers, if any, are dialed
autornatically if the primary phone number cannot be
reached. They may alzo be uzed to zet different
numbers on individual multi-inked ISOM lines.

Phone number;

Altermates. . |

™ Use Telephory dialing properties

¢ Back I Meut > I Cancel

Complete the following steps:

Table 82: Go to the next dialog

Step Action

1 Omit this dialog.

Press the Next button.
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Set up complete

Figure 84:
New Phonebook Entry Wizard

Mew Phonebook Entry Wizard

That's it.

Presz Finizsh to save My DECT Syatem’.

< Back Cancel

Complete the following steps:

Table 83: Set up complete

Step Action

1 Complete the set up.

Press the Finish button.
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Configure the networking dial-up

Figure 85:
Dial-Up Networking

£, Dial-Up Metworking

Phonebook entmy to dial:
My DECT Spstem =l

Phane number pressiew:

Dhialing fram:

INew Location j

Location... |

Did | Clse |

Complete the following steps:

Table 84: Configure the networking dial-up

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select edit phone book.

Under the More drop-down list, select Edit entry and modem proper-
ties.
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Configure the Dial using entry

Figure 86:
Edit Phonebook Entry - Basic

Edit Phonebook Entiy H
B asic 1 Sepver ; Script | Security ; o 26 ;
Entry name: iM_I.J DECT Spstem
Comment;: i

Phone number: i Alternates...

™ Use Telephony disling properties

Dial using: FAS Serial Cable between 2 PCs [l IRl KN

W Usge another part if busy

QK 1 Cancel

Complete the following steps:
Table 85: Configure the Dial using entry

Step Action
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Table 85: Configure the Dial using entry

Step Action

1 Configure an entry from the Dial using drop-down list.
Note: The list shows modems you previously configured.

Select an appropriate entry from the Dial using drop-down list.

2 Accept the changes.

Press the OK button.
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Configure the Dial-up server type

Figure 87:
Edit Phonebook Entry - Server
Edit Phonebook Entry
Basgic Server | Script ; Secuity ; w25 ;

Diial-up gerver bype:
;F'F'F': Windows NT, Windows 95 Plus, Internet _:j

Metwaork protocols
| ¥ ICRAP
[ IP%/5P compatible
[ HetBELI

¥ Enable software compression

W Enable PPP LCF extensions

ak Cahicel

Complete the following steps:

Table 86: Configure the Dial-up server type

Step Action

1 Configure the Dial-up server type.

Select PPP: Windows NT... and check the boxes shown in Figure 87.

2 Open the PPP TCP/IP Settings dialog.

Press the TCP/IP settings button.
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Configure IP address

Figure 88:
PPP TCP/IP Settings

PPP TCP/IP Settings

™ Server assigned IP address

IP address: 192 168 . 1 . 200

* Server assigned name server addresses

—{" Specify name server addiesses

Frirman [ 5 o.0.0.10
Senondan D5 o.o0.0.10
Friman i S o.o0.0.10
Secondan WIS o.0.0.0

¥ Use IP header compression

W Use default gateway on remote network

(1] I Cancel
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Complete the following steps:

Table 87: Configure IP address

Step Action

1 Select the settings.

Click the Specify an IP address and the Server assigned name
server address radio buttons.
Click on both check boxes.

2 Specify an IP address.

Enter your IP address.
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Accept the configuration changes

Figure 89:
Services

Edit Phonebook Entry K

Bazic Server | Script ; Security ; K25 ;

Dial-up server type:
]F'F'F': Windows MT, Windows 95 Pluz, Intermet :__j

Metwork, protocols
¥ ICPAP
[ IP45P= compatible
[~ HetBEUI

W Enable software comprezsion

¥ Enable PPF LCP extensions

] Cancel

Complete the following steps:

Table 88: Accept the configuration changes

Step Action

1 Accept the configuration changes.

Press the OK button.
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Establish the RAS connection

Figure 90:
Dial-Up Networking

2%, Dial-Up Networking

Phonebook entry to dial;

Phone number prewvies:

Dialing fram:

INew Location j

Location. .. |

Dl |  Close |

Complete the following steps:

Table 89: Establish the RAS connection

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Dial-up Networking.

2 Select your Phonebook entry to dial.

Highlight your entry.
3 Dial.

Press the Dial button.
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Establish a connection to the DECT system

Figure 91:
Connect to my DECT system

Connect to My DECT System

Enter a uzer name and pazsword with access to the
remote netwark, domain,

Usger name: i.-‘-‘-.clministratol

Pazzward: ;

Domain:  [MLY-OTM

[ Save password

IT; Cancel i Connecting to My DECT System...

Reqistering your computer on the network..

Complete the following steps:

Table 90: Establish a connection to the DECT system

Step Action

1 Establish access.

Note: No input to this dialog needed.

Press the OK button.
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Establish connection complete

Figure 92:
Connection Complete

Connection Complete

B . heve suceesshully connected ta the remate

[ zerver. You may now uze the uzual Windows MT

. pragramsz and utilities az if you were directly
connected to the network.

Right-click the Dial-Up Metwarking Monitar on the
tazk bar to hang up or check the statuz of your
connection.

The 'Cloge on dial' option hides the phonebook
while dialing and clozes it az s0on az you connect.

™ Do wot display this message again

Complete the following steps:

Table 91: Establish connection complete

Step Action

1 Finish.

Press the OK button.
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Set the IP address through Telnet

Figure 93:
Connect
Connect
Host Name: ] 92.168.1.1 vi
Port: !telnet _vj
TermType: Ivﬂl]l] _vj
Connect i Cancel i

Complete the following steps:
Table 92: Set the IP address through Telnet

Step Action

1 Open the Dial-up Network property dialog on Windows NT.

Start> Program> Accessories> Telnet.

2 Address the DMC8 Relay card using the card’s default IP address.

Enter 192.168.1.1 in the Host Name: box.

3 Connect to the DMC8 Relay card.

Press the Connect button.
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Configure the IP address

Figure 94:
Telnet 192.168.1.1

o Telnet - 192.168.1.1

Connect  Edit Terminal Help

Y
login: dasuser :j

password:

local> ipconfig

wrong format..

ipconfig <ipaddress> <{subnet>[ <{gateway>r]

local> ipconfig 192.168.1.25 255.255.255.08 192.168.1.2688

Complete the following steps:

Table 93: Configure the IP address

Step Action

1 Login.

Enter dasuser.

2 Password.

Enter dasuser.

3 Configure the IP address.

Use ipconfig as shown on the bottom line in Figure 94.

4 Disconnect the Telnet connection.

Click on the close box in the upper right corner.
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Hang-up the RAS connection

Figure 95:
Dial-Up networking

Phonebook entry to dial:

Phone number presiew:;

Cialing from:

INew Location

=
Location... |

Hatg Up I Cloze |

Complete the following steps:

Table 94: Hang-up the RAS connection

Step Action

1 Hang-up the RAS connection.

Press the Hang Up button.
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Multi-Site Mobility Networking

This chapter contains the following topics:

Featureimplementation. . ............ .. ... i 179
Feature Operation . . ... ..ot 183

Feature implementation

The sequence of actions required to set-up this feature are as
follows:

1 Configure a phantom superloop using LD 97, if required.
2 Create the new DCS sets in LD 10.

3 Configure the RCFW data in LD 57 and LD 15 for handsets
assigned as a visitor.

4 Use the DECT manager to configure sets on the DMC8.
Pre-subscribe the visiting handset one time at the MCDN node.

configuration. For DECT Manager configuration, see the Meridian

NOTE
g Subscription includes both overlay configuration and DECT Manager
Companion DECT NTP.
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LD 10 — Add/Change DCS data block or data blocks.

Table 95: Add/Change DCS data block or data blocks

Prompt
REQ

Response
NEW, NEW

1-255, CHG,
ECHG

Description
NEW = Add a Digital Cordless Set

NEW X = The generation of new DCS units stop
when the maximum Index of 509 is reached on a
single DMC8 or VTNs on the system run out or
WRLS ISM limits reached. All new DCS must be
on the same DMCS8.

CHG = Allows the DCS configuration to change to
another DMC8. All new DCS must be on the same
DMCS8.

ECHG = This command can change either the
VSIT response or the HMDN response.

TYPE

DCS

Digital Cordless Set.
Differentiates between analog sets and non-con-
centrated digital Companion DECT handsets.

If TYPE=DCS, the system allocates the next
available VTN, and WRLS defaults to YES and
WTYP defaults to DECT. If package #350 is
included, MWUN defaults to 32.

CLS defaults to ERCA, allowing the Enhanced
RCFW feature.

TN

Iscu
lu

TN on an IPE shelf or Option 11C cabinet. The
system provides the Virtual TN for the handset.

CDEN

(4D)

Card Density. Only valid value for IPE is 4D. Nor-
mal input is <CR>.

WRLS

YES

WiReLess analog Set - entry defaults to YES with
no user input - value cannot be CHG’ed.

WTYP

DECT

Wireless TYPe - entry defaults to DECT with no
user input - value cannot be CHG’ed.

MWUN

32

Maximum number of Wireless UNits - entry
defaults to 32 with no user input - value cannot
be CHG'ed.

Note - if MWUN = 32, CDEN automatically
changes to 8D, and prints as an 8D unit.
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Table 95: Add/Change DCS data block or data blocks
DMC8 I'sc Location of the actual DMCS8.
¢ (Opt.11c) Assigns a TN to a QECT MObI|It.y Card located on
an IPE shelf or Option 11C cabinet.

INDX 0.. 509 DMC8 index to map the Virtual TN to a DMC8 TN.
Starting index on DMC8, each unit increments to
the next available unit.

VSIT (NO)/IYES ViSITing DECT set. Determines the difference
between a local handset and a visiting handset.
VSIT available if the MSMN Package is unre-
stricted.

YES=visiting DECT set. NO=local DECT set.

HMDN X...X HoMe Directory Number. Sets the DN as a valid
MCDN network DN.

NMDN available if VSIT=YES.
LD 10 - Copy DCS data block or data blocks.
Table 96: Copy DCS data block or data blocks

Prompt Response Description

REQ CPY 1-32 CPY n = The generation of new units stop when
the maximum index of 509 is reached on a single
DMC8 or VTNs on the system run out or WRLS
ISM limits reached. All DCS must be on the same
DMCS8.

DMCS8 Isc Location of the actual DMC8 to copy on an IPE

| (Opt 11C) shelf or Option 11C cabinet.

LD 10 — Remove DCS data block or data blocks.

Table 97: Remove DCS data block or data blocks

Prompt Response Description
REQ OUT 1-255 OUT X = Removing units stops when the maxi-
mum index of 509 is reached on a single DMCS8.
All new DCS must be on the same DMCS8.
DMC8 Isc Location of the actual DMC8 to out on an IPE
| (Opt 11C) shelf or Option 11C cabinet.
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LD 10 - Convert handset type 500 to DCS

Table 98: Convert handset type 500 to DCS

Prompt Response Description

REQ CDCS Convert Digital Cordless Set - convert from a
non-concentrated to a concentrated system after
software upgrade. The conversion routine con-
verts the 500 units to DCS units and moves them
from the actual TN to a virtual TN.

NOTE
To convert from concentrated to non-concentrated, OUT all DCS
units and re-subscribe the handsets.

The CDCS conversion routine prints each TN as it is moved, in the
following format:

500 TN 1 s ¢ 00 = DCS TN L' S’ C' Index#.
where: L' S’ C' = virtual TN
Index# = default of the unit number of the 500 type set.

LD 20 — Print actual DMC8 TN and virtual DMC8 TN list.

Table 99: Print actual DMC8 TN and virtual DMC8 TN list

Prompt Response Description

REQ PRT Request.

TYPE DCS Digital Cordless Set.

TN I'sc Terminal Number for actual DMC8 on an IPE shelf
| (Opt 11C) or Option 11C cabinet.
I's' ¢ u Virtual Terminal Number on an IPE shelf or

Option 11C cabinet.

I"u’ (Opt 11C)
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The print routine outputs the following format:

INDX Index # VTN Il s ccuu
where: Index # = Index number of virtual TN.
Ill's cc uu = Virtual TN of unit.

LD 81 — Print DCS features

Table 100: Print DCS features

Prompt Response Description

REQ LST Request.

FEAT VSIT Feature Request - DECT visitors.

HMDN Xx [ <cr> HoMe Directory Number. Specify a single HMDN

or print all HMDN on system.

The LD 81 output format as follows:

DCS Cust# Local DN TN Il sccuu HMDN Home DN Last
Activity Date.
where: Cust# = Customer Number

Local DN = Local Directory Number of user

Il s cc uu = TN of unit

Home DN = Home directory number of user

Last Activity Date = Last date of service change activity for user

LD 83 — Prints DCS terminal numbers with a unit type of DCS instead
of 500.

Feature operation

To activate the MSMN feature:

e turn the handset on within the coverage range of a visited
Companion DECT system

e enter the coverage range of a visited Companion DECT system
from another Companion DECT system with the handset on
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To deactivate the MSMN feature:

e turn the handset off within coverage range of the visited
Companion DECT system (The handset must have the DECT
Detach feature.)

e turn the handset on at the home Companion DECT system (Any
CFW related to the handset cancels.)

e enter the coverage range of the home Companion DECT system
with the handset on (Any CFW related to the handset cancels.)
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Appendix 1: Upgrade an MDECT
system to a SNMP managed system

There are two types of manager for MDECT systems:
e Windows Manager
e OTM with DECT application

The Windows Manager, a non-SNMP device, is used to manage
the first generation of MDECT systems. The present generation
of MDECT systems are managed by an OTM with a DECT
application.

NOTE
The following terms are used in this appendix:

The DMC (NTCWAOOAA) and DMC-E (NTCWO01AA) are
referred to as DMC4 and DMC4-E.

An MDECT system equipped with both DMC4/DMC4-E and
DMC8/DMCS8-E are referred to as a Mixed MDECT system.

An OTM can manage a DMC4/DMC4-E MDECT system or a Mixed
MDECT system.

A DMC4/DMC4-E MDECT system or a Mixed MDECT system managed
by an OTM must have SNMP firmware.

A Mixed MDECT system must be managed by an OTM. In a Mixed
MDECT system a DMC8/DMC8-E must be the Relay card.
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In a DMC4/DMC4-E MDECT system or a Mixed MDECT system,
managed by an OTM, the DMCs must run 451001xx.dwl software, and
the DMC8s/DMC8-Es must run 470001xx.dwl software.

Connecting an OTM to a DMC4 Relay card using an Ethernet
connection is not supported. You can only use a V.24 connection.

Backup the DMC4 data with Windows Manager

Figure 96:
DECT Manager window

: BDECT Manager [Lab Opt 11] |_ O] x|

File “iew Subscriptions gsl Radios  Configuration  Help

@ Refresh Boards FT Té—

Refresh Al Refresh Backup Ctrl+B Connect
Festore Cirl+F
Subscriptions  Boards I Ra  cotn configuration
Address | Ope Comrent =
4 fes reanat ?Dard Relay board
5 Mo Upload Firmware =
; Diztribute Firmswvare
¥ Show Dperationd Clear board e |
1]
¥ Show Mot Operational
| Ready [Diszornected] |PARK 31104421464207 | £/23/93 [11:234M 2
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Complete the following steps:

Table 101: Backup the DMC data with Windows Manager

Step Action

1 Launch the Windows Manager program.

Double click on the DECT-Manager icon.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.

4 Select all DMC4s.

Highlight all addresses.

5 Backup the DMC4 data.

Click on the Backup button.

6 Close the connection to the relay card.

From the toolbar, click on the Connect icon.
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Upload OTM supporting firmware to the
DMC4 Relay card

Figure 97:
DECT Manager window

: BDECT Manager [Lab Opt 11] M=
File “iew =ubzcriphons REadioz Configuration  Help
%] Refresh Boats F7 _é_
Refresh Al Refresh Backup Ctrl+B Connect
Restore Ctrl+F

Subscriptions  Boards I Ba  goto configuration

.id:lress |5I.Z|: e Comment ﬂ

5 Mo Uplosd Firtrsware ;l

Chztribte Flrmnsare

¥ Show Operationd Clear board

Hestore |

v Shaow Hat Dperational

[ Feady [Diszannected] [PARK 3104421464207 B/23/99 [11:238M

Complete the following steps:

Table 102: Upload OTM supporting firmware to the DMC4 Relay card

Step Action

1 Load the OTM supporting 451001xx.dwl firmware file on your Windows
Manager PC.

2 Select the Companion system.

Highlight the system and click on the OK button.

3 Select the Boards tab.

Place the cursor on the tab and click.
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Table 102: Upload OTM supporting firmware to the DMC4 Relay card

Step Action

Select the Relay DMC4.

Highlight the address.

5 Upload the 451001xx.dwl firmware file to the Relay DMC.

From the Boards pull-down menu, click on Upload firmware.

Close the Windows Manager

Figure 98:
Close Program dialog

i Cloge Program HE

EH.JI. o
Aeabplay
Loadwc
Firlast
Oza

N svapmd?
Comsmd
mblags
Abcwed 32

Syshiay :I

WARMING: Piessrg CTALLALT +DEL agan will restal poia
compaern. You wil loee unsaved niosmabon in all progaams
fhal ane mnnimg

| End Task I Skt Diawe Cancel
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Complete the following steps:

Table 103: Close the Windows Manager

Step Action

1 Open the Close Program dialog.

Press the Ctrl + Alt + Delete keys.

1 Disable the Windows Manager.

Select DECT Manager and press the End Task button.
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Change the DMC4 Relay card default

|IP address
Connect the DMC4 Relay card to a configuring PC

CAUTION: Service interruption

You must change the DMC4 address to conform to your net-
work IP address plan.

Figure 99:
NTCW12AA cable to Configuring PC connections

DMC4 Relay card ¢

Configuring PC

MDECT System

. . . . .. .U. NTCW12AA

MDF to modem
cable

A0773252
Null modem
adaptor
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NOTE
The configuring PC can be the OTM server or another PC.

If your configuring PC is the OTM server, the Configuring PC
shown in Figure 99 will be the OTM Server shown in Figure 101 on
page 195.

Table 104: Connect the DMC4 relay card to a configuring PC

Step Action

1 Connect the NTCW12AA cable to the Configuring PC.

Insert the NTCW12AA cable into the A0773252 Null Modem Adaptor
and connect to the Configuring PC.
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Reset the DMC4 Relay card to your IP address

You must change the Relay DMC4 IP address to conform to your
server network IP address plan.

Figure 100:
Telnet 192.168.1.

o Telnet - 192.168.1.1

Connect Edit Terminal Help

login: dasuser :j

password:

local> ipconfig

wrong format..

ipconfig <ipaddress> <{subnet>[ <gateway>]

iucal) ipconfig 192.168.1.25 255.255.255.0 192.168.1.2080

Complete the following steps:

Table 105: Reset the Relay DMC4 IP address to your LAN IP address

Step Action

1 Open the Telnet dialog.

Click on Start>Accessories>Telnet.
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Table 105: Reset the Relay DMC4 IP address to your LAN IP address

Step Action

2 Enter user name and password.

Type user name dasuser and password dasuser.

3 When the connection prompt local appears, change the Relay DMC4
card address.

Enter the following command:
ipconfig XXX.XXX.XXX.XXX YYY.YYY.YYY.YYY 222.222.222.222

XXX.XXX.XXX.XXX = new IP address of the Relay DMC4 card.
YYY.YYY.yyy.yyy = subnet mask, usually 255.255.255.0
zzz.zzz.zzz.zzz = |P address if this is the gateway for your network.

Note: zzz.zzz.zzz.zzz should be setto the IP address of the OTM server
Ethernet interface. If you have two Ethernet interfaces on the OTM
server, zzz.zzz.zzz.zzz should be set to the IP address of the interface
which is on the same network as the DMC4 Relay card.

Connect the DMC4 Relay to the OTM server

NOTE

You must connect the OTM server to a DMC4 Relay card using
a V.24 connection. Connecting an OTM to a DMC4 Relay card
using an Ethernet connection is not supported.
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Figure 101:
OTM Server to DMC4 relay connections local and remote

Local

OTM Server

DMCA4 Relay card

T

NTCW12AA AQ0773252 Standard
MDF to modem Null modem DB-25 to DB-9

l . ' ' " .O. ‘ cable adaptor cable

Remote
OTM Server

DMC4 Relay card

JICTES

Standard
NTCW12AA DB-25 to DB-9
MDF to modem cable

cable r,r"""“«.-

r

( esmv )
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Complete the following steps:

Table 106: Connect the DMC4 Relay to the OTM server

Step Action

1 Connect the OTM server to the DMC4 Relay card.

Refer to “Add a V.24 serial connection” on page 139.
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Add your MDECT system
Add General System Properties

Figure 102:
DECT Systems and DECT System Properties
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Complete the following steps:

Table 107: Add your MDECT system

Step Action

1 Open the DECT System Properties dialog.
Pull down File>Add.

2 Enter the MDECT system name.

Type your system name in the DECT System Name box.

Accept the changes.

Click on the Apply button.
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Set the MDECT system IP address to match
the DMC4 Relay card

Figure 103:
System Properties - Communication

Optivity Telephony Manager - DECT System Properties
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Complete the following steps:

Table 108: Set your IP address of the DMC4 Relay card in the manager

Step Action

1 Open the Communications dialog.

Click on the Communications tab.

2 Enter the IP address.

Type the IP address you entered in Table 105 on page 193.

3 Select Serial.

Click on Serial radio button, and go to “Add a V.24 serial connection” on
page 139.

4 Accept the changes.

Click on the OK button.

Note: When you click the OK button or Apply button at this point, the
manager attempts to connect to the MDECT system to write the MIB2
system name.
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Synchronize data with the MDECT system
When your DECT manager connects to the MDECT system,
synchronization occurs. You now have the opportunity to update the
OTM database with the MDECT system data.

Figure 104:
DECT Systems, and a synchronize dialog
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Complete the following steps:

Table 109: Synchronize data with the MDECT system

Step Action

1 If the toolbar icon is red your already connected to the MDECT system.
Disconnect from the MDECT system.

Double click on the icon, or use File>Disonnect.
Go to step 3.

2 If the toolbar icon is green.

Go to the next step.

3 Re-connect to the MDECT system.

Double click on the red icon, or use File>Connect.

4 Store the MDECT system data in the OTM Manager database.

Click on the Update DECT Manager button on all synchronization dia-
logs.
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Confirm the active software package on the
DMC4 Relay card

Figure 105:
DMC window and DECT Board properties dialog
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Complete the following steps:

Table 110: Confirm the active software package on the DMC4 Relay card

Step Action

1 Examine the Active Software Package on the DMC4 relay in the DMC
window list.

Active Software Package must be 451001xx.dwl firmware, the same as
you loaded on page 188.

2 Close the DMC window.

Click on the close box.
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Activate the firmware on all DMC4s

Figure 106:
DECT Systems window

Liploag
Ariivalon
=t =101 x|
File  Wiew Applicalions  Firreare  Wirdews  Hep
e
+
O This her dignwly © AIIDECT Syslzrms
Siie | Werdan | JECT Systern | Alarm | 1P Address AR Concentration | Mumaer of Users | Connectaon

Samale ... tost 10218814

Complete the following steps:

Table 111: Activate the firmware on all DMC4s

Step Action

to all DMC4s.

1 Activate the 451001xx.dwl firmware the same as you loaded on page 188

From the Firmware pull-down menu, click on Activate.
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Monitor the firmware activation

Figure 107:
DMC window
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Complete the following steps:

Table 112: Monitor the firmware activation

Step Action

1 Examine the Active Software Package on the DMC4 relay in the DMC
window list.

Active Software Package must be 451001xx.dwl firmware on all DMCs
the same as you loaded on page 188.
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